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1 Introduction
Data acquisition is the foundation of sound decision making. Therefore, after the
work of the empiricist who laid the philosophical foundation of the data driven
inference (Berkeley, 2003; Hume, 1902; Locke, 1860), significant efforts were
carried in developing methods aiming at acquiring representative information for
describing reality. The main instrument created to provide unbiased representation
of reality was sampling (Avery and Burkhart, 2015; Cochran, 1977; Gillis et al.,
2007; Johnson, 2000; Kershaw et al., 2017). However, the strength of sampling,
which is selection of a reduced number of individuals from a population, became
its weakness in the current technological savvy era. Remote sensing is one of the
current technologies that matured to the point of being able to provide data that
allows extraction of the relevant information for all the members of a population.
Among the remote sensing technologies, the one relying on unmanned aerial
vehicles is without the doubt the newest one. The advent of unmanned aerial
systems (UAS) is rooted in traditional aircraft experience, but it’s explosive
development is based on computer science and material sciences. Miniaturization
of devices without compromising the computation power allowed for controlling
the UAS during the flight without addition of heavy equipment. Computer
sciences has also helped on the data processing front, as there is no need for
placing sophisticated devices on the UAS to measure the location and angles of
the unit during the flight. Techniques such as Structure from Motion (SfM) or
Simultaneous Location and Mapping (SLAM) allows for acquisition of images
with poor location information from which accurate orthorectified images are
produced. The material sciences also contributed significantly to the increased
usage of UAS, as it developed multiple sensors, ranging from ultraviolet to long
wave infrared, at a reduced costs. Cameras such as Rededge or FLIR Vue Pro
revolutionized how we look at the surrounding reality. Being at the beginning of a
predicted long road, the UAS based investigations are marred by limited
agreement in terms of terminology and approaches. Therefore, it is necessary to
have materials that summarize the existing body of literature at a certain point in
time, which will serve as benchmarks through time. Consequently, the objective
of this document, conceived as a manual, is to provide a summary of the existing
approaches and regulations governing the current UAS based investigations. The
material presented in the manual is designated for practitioners and researchers
actively using the UAS, and can be used by recreational users. The document has
three components, one dedicated to the UAS regulations, one to flight preparation,
and one to image processing. The manual can be used for teaching and as a handson guide.
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2 UAS Regulations
A complete set of rules and regulations governs the usage of UAS for
research and commercial applications. The Federal Aviation
Administration (FAA) created a set of rules tailored to the objective of
UAS flight. FAA identified four types of objectives for a flight of an UAS:
recreational, commercial, public safety/government, and educational. The
focus of this document is UAS for commercial applications, but a succinct
description of each type of flight is provided.
Before diving into the details of the FAA regulations, it is appropriate to
start by defining some of the terms that will be subsequently used in the
document. First FAA defines a small UAS or a small drone, for short, as a
flying vehicle weighting less than 55 pounds that is controlled from the
ground, as there is no human on board. This document is entirely focused
on small UAS. Second, the FAA separates the airspace into six distinct
classes identified by letters from A to E and G (Figure 1). The classes A to
E form the air controlled airspace, which according to FAA is where the
“air traffic control service is provided to IFR (i.e., instrument flight rules)
flights and to VFR (i.e., visual flight rules) flights in accordance with the
airspace classification”. Because the UAS cannot fly in the controlled
airspace, this document will provide only a brief description of classes A
to E. Class A is from portion of the airspace above 18,000 feet above
mean sea level (MSL) up to and including flight above a pressure altitude
of 60,000 feet. Class B is the airspace surrounding the busiest airports in
terms of IFR operations or passengers traveling. Class B encompasses the
airspace from surface up to 10,000 feet MSL. Class C is the cylindrical
airspace surrounding the “airports that have an operational control tower,
are serviced by a radar approach control, and have a certain number of IFR
operations or passenger enplanements”. The height of the class C cylinder
is the at most 4,000 feet above the airport elevation and the radius is 5
nautical miles. Additional constraints define a more sophisticated shape
for classes B and C, which is beyond the scope of this document, but can
be found on the FAA webpage and summarized in Figure 1. Class D has a
simpler definition, and according to FAA is the “airspace extends upward
from the surface to 2,500 feet above the airport elevation (charted in MSL)
2

surrounding those airports that have an operational control tower”. Class E
airspace is that portion of the atmosphere surround the USA that has the
following six designations: 1) Surface area designated for an airport where a
control tower is not in operation, 2) Extension to a surface area, 3) Airspace
used for transition, 4) En Route Domestic Areas, 5) Federal Airways and
Low-Altitude RNAV Routes, and 6) Offshore Airspace Areas.
Class G airspace is the portion of the atmosphere that is uncontrolled for air
traffic, and consequently was not designated as Class A, Class B, Class C,
Class D, or Class E airspace. Class G is the portion of the airspace where
UAS can fly, subject to FAA regulations.

Figure 1. Airspace classes according to FAA (source faa.gov)

2.1 FAA Regulation for non-commercial use
A small UAS (i.e., less than 55 lbs) is flown for noncommercial use if the
system is flown for recreation, public safety, government use, or
educational. For all the previous mentioned situations specific guidelines
were elaborated by FAA. Because the present document can be used for
flights designated as commercial or noncommercial use, details on the two
aspects of the FAA regulation will be provided.
3

2.1.1

FAA regulations for Recreational Flyers

Any person flying UAS for recreational purposes is considered a
recreational flyer. The “FAA Reauthorization Act of 2018” promoted by
the Congress of the USA in 2018 establishes clear guidelines for
recreational flights, which are summarized in 10 sections:
1. The UAS must be registered with the FAA, and the registration
number should be placed on an obvious place on the unit. Proof of
registration should be carried with the person flying the unit.
2. The objective of the flight is for recreational purposes only.
3. The fight should occur only in airspace where the FAA is not
controlling manned air traffic or in the “Class G” airspace. FAA
provides a complementary description of the Class G, which is the
“typically the airspace very near the ground (1,200 feet or less),
beneath class E airspace and between class B-D cylinders around
towered airstrips”.
4. The UAS must be flown below 400 feet when in uncontrolled or
"Class G" airspace.
5. Flying in controlled airspace (around and above many airports) is
permitted ONLY when:
• an airspace authorization for operations in controlled
airspace through the Low Altitude Authorization and
Notification Capability is received before the fly.
• The flight is executed at a recreational flyer fixed site that
has a written agreement with the FAA.
6. The UAS must be within the line of sight, or within the visual lineof-sight of a visual observer who is co-located and in direct
communication with the pilot of the UAS.
7. Flight close to other aircrafts are not permitted, especially near
airports.
8. Flights over groups of people, or public events are not permitted.
9. Flights near emergency situations, such as any accidents, law
enforcement activities, firefighting, or hurricane recovery efforts
are forbidden.
10. Flights under the influence of drugs or alcohol are forbidden
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2.1.2

FAA regulations for public safety and government

UASs are powerful tools that can help Public Safety Agencies in detecting
and investigating the unauthorized or unsafe operations of UASs.
Government agencies, such as Federal, State, and tribal, as well as law
enforcement and public safety entities can operate a small UAS using one
of the two options:
•

•

Fly under the 14 CFR part 107, which allows operation of UAS under
55 pounds below 400 feet above ground level that are within the visual
line-of-sight.
Fly under the statutory requirements for public aircraft, namely the 49
U.S.C. §40102(a) and § 40125, which requires a Certificate of Waiver
or Authorization (COA). The COA provides the ability of the agency
or entity to certify UAS and operators for governmental flights.

2.1.3

FAA regulations for education

The FAA developed a series of regulations for education that are between
commercial use and recreational use. From the regulatory perspective, an
UAS can be flown for educational or instructional purposes under one of
the two cases: under Part 107 or as a recreational flyer.
2.1.3.1 Educational flights under Part 107
Part 107 of the 14 CFR establishes the main set of rules for flying small
UAS (less than 55 lbs.) in the United States. Part 107 offers the legal
framework for any flight, such as education, but includes business, fun, or
public safety missions. To fly for education purpose under part 107 rules,
there are 3 main steps, steps that are encountered to the commercial flights
too:
Step 1: Learn the Part 107 Rules. It is obvious that a person who wants to
teach or educate others on UAS should be familiar with the regulations
governing UAS activities. There are many materials online that help
learning the rules associated with UAS, all of them based on FAA website,
which is the main source of information related to UAS regulations.
Step 2: Become an FAA-Certified Drone Pilot. Any person that is at least
16 years old, is able to communicate fluently in English, and is physically
and mentally able to safely fly an UAS can become a FAA-certified drone
5

pilot. To receive the certificate of drone pilot from FAA the person should
pass a competency test that can be taken at a FAA-approved Knowledge
Testing Center. The location of the testing centers are found on the FAA
website.
Step 3: Register your UAS with the FAA. The flying vehicle should be
registered, similarly to an automobile. The registration costs $5 and is
valid for 3 years.
2.1.3.2 Educational flights as recreational flights
FAA offer the opportunity to fly for educational purposes using the same
rules as for recreational flights. The process contains also three steps, as
for flights under Part 107, but without requiring the examination at an
FAA accredited facility.
Step 1: Register Your UAS with FAA. All UAV weighting more than
0.55 pounds must be registered with FAA. The person registering the
UAV must be at least 13 years old, and pay the registration costs, which in
2020 is $5. The registration is valid for 3 years.
Step 2: Review the Rules. Because there is no testing required, the pilot is
responsible for knowing the regulations governing educational flights.
FAA list six rules that should be followed when flying for educational
purpose as recreational flight:
•
•
•

•
•
•

The flights is only for recreation
The flight is at or below 400 feet when in uncontrolled airspace
(Class G)
The flight is within the visual line-of-sight, which means that the
pilot must seat all times the UAS without enhancing devices (such
as binoculars
The flight does not occur near other aircraft.
The flight does not occur over groups of people or public events.
The flight does not occur near or over emergency response efforts.

Step 3: Know where to fly. The pilot is responsible for complying with
FAA guidelines and regulations, which means that the pilot must know
where it is and where it is not safe to fly.
6

2.2 FAA regulations for commercial use
Flight executed for commercial purpose has the same requirements as
flights for education. Therefore, commercial flights of UAS are executed
only under Part 107. FAA lists three steps to allow for UAS commercial
flights.
Step 1: Learn the Rules governing the UAS commercial flights. The main
rules that a pilot of a small UAS should follow are:
•
•

•

•
•

•

•
•
•

The UAS must weigh less than 55 lbs. (25 kg), including the payload
The flight should be executed only with visual line-of-sight (VLOS).
This means that the UAS must be within VLOS of the pilot in
command and the person manipulating the flight controls of the small
UAS at all times. However, FAA offers as alternatively that the UAS
is within the VLOS of the visual observer. The UAS must be close
enough to the pilot in command and the person manipulating the flight
controls of the UAS such that the aircraft can be seen with unaided
vision, except corrective lenses.
Devices ensuring first-person view do not meet the “see-and-avoid”
requirement. However, they ca can be used, but the “see -and -avoid”
requirements must be met in other ways.
During the UAS flight a visual observer (VO) can be used but is not
required.
The UAS flight should not occur over any persons not directly
participating in the operation, or under a covered structure or a covered
vehicle.
The flights should occur only during the day or civil twilight (30
minutes before official sunrise to 30 minutes after official sunset, local
time). If the flight happens during the civil twilight, then appropriate
anti-collision lighting should be mounted and operated on the UAS.
The UAS must yield right of way to other aircraft.
The maximum groundspeed of the UAS should not exceed 100 mph
(87 knots).
The flying altitude of the UAS should be at most 400 feet above
ground level (AGL). However, if there are structures higher than 400
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•
•

•

•
•
•
•

feet in the area surveyed by the UAS, the UAS can fly above 400 feet
but must be within 400 feet of a structure.
The UAS cannot be flown in weather that has less than 3 miles
visibility from control station.
Flying a small UAS in Class B, C, D and E airspace is forbidden
without the air traffic control permission. A small UAS can be flown
in Class G airspace without air traffic control permission.
A person should as act as a pilot in command of a small UAS for only
one flying aircraft at the time. Similarly, a person may not act as visual
observer for more than one flying UAS at a time.
A small UAS may not be operated from a moving aircraft.
A small UAS may not be operated from a moving vehicle, except
when the flight occurs over a sparsely populated areas.
A small UAS cannot be operated carelessly or recklessly.
The payload of a small UAS cannot be a material deemed as
hazardous.

There are flights that are not covered by Part 107, but can be executed if a
waiver is obtained. The most common examples of Part 107 sections that
are subject to a waiver are:
•
•
•
•
•
•
•
•
•

Flying a small UAS from a moving vehicle or aircraft (§ 107.25)
Extension beyond the daylight operation (§ 107.29)
Relaxation of the visual line of sight requirement (§ 107.31)
Presence of the visual observer (§ 107.33)
Operation of multiple small unmanned aircraft systems (§ 107.35)
Yielding the right of way (§ 107.37(a))
Operation over people (§ 107.39)
Operation in certain airspace (§ 107.41)
Flying only for small unmanned aircraft (§ 107.51)

Step 2: Become an FAA-certified UAS pilot. To operate a small UAS for
commercial purposes, the FAA requires the passage of a pilot knowledge
test. To be eligible to receive a certificate of remote pilot a person must
meet three criteria:
•

To be at least 16 years old
8

•
•

To be able to communicate in English
To be in a physical and mental condition to safely fly a UAS

The FAA provides a full set of test preparation materials on the FAA
website. The material contains five parts: the Airmen Certification
Standards, the Knowledge Test Instructions, the Knowledge Test Study
Guide, the Knowledge Test Sample Questions, and the Pilot's Handbook
of Aeronautical Knowledge. Familiarity with all five parts is mandatory,
as the knowledge test will have questions from all five parts. After the test
is passed, to receive the remote pilot certificate the FAA Form 8710-13
(FAA Airman Certificate and/or Rating Application) must be completed.
The form is online, and can be found under the acronym IACRA,
Integrated Airman Certificate and/or Rating Application system.
Step 3. Register the small UAS with the FAA. After the pilot certification
is achieved the small UAS must be registered before any commercial
flight. Similarly to registration for education under Part 107, the
registration costs $5 and is valid for 3 years. The registration is done
online at dronezone.faa.gov, where the option "Fly UAS under Part 107"
must be selected. The registration number should be affixed on the UAS.

2.3 Western State Regulations
Besides the federal rule governing the small UAS flights, many states have
adopted additional laws. In this document, only the laws and regulations
pertinent to the western USA are presented: California, Idaho, Montana,
Oregon, and Washington.
2.3.1

California regulations

Besides the FAA regulations, the state of California, promoted a series of
rules that are more restrictive than the FAA regulations. In California there
are three bills regulating the use of UAS, namely the SB 807 bill from
2016, the AB 1680 bill from 2016, and the AB 856 bill from 2016. The SB
807 bill provides immunity to first responders who damage a UAV that
impacted their activities while emergency services were provided. The bill
AB1680 takes the SB 807 even further, making the interference with the
activities of the first responders during an emergency a misdemeanor. The
AB 856 bill prohibits entering the airspace of an individual with the
purpose of capturing images or videos without permission.
9

2.3.2

Idaho regulations

Similarly to California, Idaho promoted a series of bills that further
strengthen the FAA regulations. Idaho has two bills that regulate the usage
of UAS, the bill SB1213 from 2016 and the bill SB 1134 from 2013. The
bill SB 1213 prohibits the use of UAS for hunting, molesting, or locating
game or fur-bearing animals. The bill SB 1134 from 2013 requires the law
enforcement agencies to have warrants to use UAS. The same bill
establishes guidelines for the use of UAS by private citizens, as well as
civil penalties for the improper use of UASs.
2.3.3

Montana regulations

Montana mirrors California and Idaho, in the sense that besides FAA
regulation there are other bills related to the usage of UAV. The bill HB
644 from 2017 prohibits the usage of UAS that hinders the wildfire
suppression efforts. The bill establishes a penalty for violations as the
amount of money equivalent to the costs of the interference. The bill SB
196 from 2013 limits the amount of information gained by using UAS that
may be admitted as evidence in any prosecution or proceeding.
2.3.4

Oregon regulations

Oregon, like California, Idaho and Montana has a number of bills passed
specifically to enhance the FAA regulations to specific situations of the
state. There are four bills passed by the Oregon assembly that detail even
further the UAS regulations: the HB 3047 from 2017, the HB 4066 from
2016, the SB 5702 from 2016 and the HB 2710 from 2013. The bill 3047
from 2017 issues a class C felony if a bullet or projectile is fired from a
weaponized UAS. The bill also prohibits the use of UAS over private
property in a manner that intentionally irritates the resident or owner. The
bill 4066 from 2016 regulates the use of drones by public entities,
including police, and issues a class A misdemeanor if a weaponized UAS
is operated. This bill also restricts the use of UAS near critical
infrastructure. The bill 5702 from 2016 established the fees for registering
a public UAS. The bill 2710 from 2013 requires registration with the
Oregon Department of Aviation of a UAS operated by a public body. The
bill also establishes procedures for a landowner to bring an action against
someone flying an UAS over their property.
10

2.3.5

Nevada regulations

The state of Nevada has only one bill amending the use of UAS besides
the FAA regulations: AB 239 from 2015. The bill is focused on the usage
of the law enforcement agencies and on the weaponized UAS, which is
not the objective of the present document.
2.3.6

Washington regulations

The most northwestern state of the conterminous United States,
Washington State, also promoted a bill regulating even more that FAA
rules and regulations. The Bill WAC 352-32-130 is focused on UAS
activities in state parks. According to the bill a UAS may be flown in any
state park area with written permission from the designated administrator.

Figure 2. Western US states with the bills additionally regulating the FAA rules
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4 UAS flight planning and UAS operation during
flight
To acquire the data needed for land monitoring, irrespective of the final
product (i.e., images or points), a series of pre-flight activities are required
(Figure 3). The pre-flights activities are
designed to ensure a successful
Preflight Activities
acquisition of data and to reduce the
high risk activity associated with UAV
data acquisition, namely the flight.
Even with all pre-flight activities
completed successfully, extreme care
Flight Operations
should be exhibited the all times while
the vehicle is in the air. Once the flight
is completed, a post-flight set of
activities should be carried out (Figure
3), to document the success of the
Post flight activities
mission or to alert the responsible
entities if issues arose before, during,
Figure 3.Flight planning: Succession of
activities for UAS image acquisition
or after flight conclusion.

4.1 Flight planning
The flight planning can be separated according to the objective of the
activities involved, namely connection to FAA information system,
preparation of the UAS, and preparation of the flight plan. Special
importance is given to the activities occurring right before the flight, as the
UAS must be inspected immediately before the flight to ensure smooth
and safe data acquisition. Many people separate the preflight activities not
according to the task accomplished but according to the place of
occurrence, namely at the office or in the field. Therefore, the connection
to FAA information system, preparation of the UAS, and preparation of
the flight plan are activities occurring at the office, whereas the actual
flight activities occurs in the field.
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4.1.1

Preparation of the flight plan

Most of the land monitoring should be executed using a flight plan rather
than flying the UAS manually, sometimes called “free flight”. A preset
flight plan is preferred in land monitoring because it combines the optimal
trajectory of acquiring data with the specifications of the sensor.
Therefore, a significant amount of details will be provided in this
document on how to create a flight plan that is tailored to the data
acquisition needs.
A plethora of packages are available to create a flight plan, some
involving a combination of a desktop or laptop and a mobile device (e.g.,
UgCS), such as smart phone or tablet, while some only use a mobile
device (e.g., Pix4Dcapture or DJI Go). As the current largest manufacturer
of UAS, DJI have developed multiple platforms through time that help in
the creation of flight plans. Unfortunately, DJI exhibited inconsistency
within its own products, such that many of its controllers now are no
longer supported by the DJI flight plan software (a famous case was the
drop in the support for the Naza and Wookong controllers). Furthermore,
the development of flight planning packages by DJI that are not free
forced the users into considering other alternatives. Therefore, in this
document the Pix4Dcapture will be used to plan a flight mission because it
is free and consistent, in the sense that the old controllers are not dropped
from the platforms. Nevertheless, considering that DJI is currently the
largest UAS manufacturer, the document will succinctly present the
current version of flight plan, called DJI Pilot.
Pix4Dcapture is one of the software developed by Pix4D, a company
based in Lausanne, Switzerland. The software supports controllers
manufactured by DJI, Parrot and Yuneec, three of the largest manufacturer
of UAS. Pix4D capture is entirely based on a mobile device, either
Android or iOS. The present document will present the main step in
planning a flight mission with Pix4Dcapture, with specific application to
DJI Mavic 2 Pro. Being an app, the software must be downloaded from
either Google Play or the App Store, depending on the operating system,
before use. In this document all the supporting material is based on the
Android version of the app, namely on the Google Play version. However,
13

irrespective of the interface each flight plan is focused on the selection of
four choices:
•
•
•
•

The controller (e.g., A2, Naza, or Phantom 3)
The type of flight path (e.g., grid or circular)
The area to be surveyed
The flying parameters (e.g., elevation and location of image
capture).

4.1.1.1 Mission planning with Pix4Dcapture
Before the flight plan is even started, most software, including a
Pix4Dcapture, require that an account is created. The account must be
connected with a valid email address (Figure 4), as all the information
would be delivered using the email.

Figure 4. Pix4Dcapture start –up interface

4.1.1.1.1 Selection of the flight controller
Immediately after login, the Pix4Dcapture interface requires identification
of the flight controller. For many flight planners, the controller has the
same name as the UAS, which is the case of Pix4Dcapture (

14

Figure 5. Selection of the flight controller in Pix4Dcapture), but for
sophisticated platforms the actual controller name appears, which is the
case of UgCS.

Figure 5. Selection of the flight controller in Pix4Dcapture

Selection of the flight path
The usual flight path of a UAS aiming at land monitoring is either as a
snake, called grid mission in Pix4Dcapture (Figure 6), or an overlapping
double snake, called double grid mission in Pix4Dcapture. The double grid
mission is preferred, as it will provide not only the orthorectified image
but also an accurate representation of the elevation. However, in many
instances technical limitation (e.g., limited number of batteries) and time
constraints could prevent the double grid. In these situations the simple
grid should be chosen. In most instances free flight is not recommended
for land monitoring, as it is suboptimal in term of UAS and image capture.

Figure 6. Predefined flight path in Pix4Dcapture
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In the eventuality that a simple grid mission is chosen, it is recommended
that the Polygon mission is selected, as it will allow for irregular shapes.
4.1.1.1.2 Delineation of the surveyed area
Once the flight path is selected, the area to be surveyed should be
delineated. Assuming that the mission follows a grid pattern, the pilot
should identify the boundaries of the areas to be surveyed, a task that starts
with the Polygon Mission screen (Figure 7).

Figure 7. Selection of the flight area boundaries

The default view in Pix4Dcapture is the vector description of the Earth
(Figure 8-left). However, if the imagery depiction of the planet is required,
a simple press on the satellite view (i.e., the third square from the bottom
left corner) will switch to the nadir view (Figure 8-right). To focus on the
area close to the current location press the

.
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Figure 8. Switch between the aerial view (right) and vector view (left) of the Earth. The first square
form the bottom left will center the image to the current location, whereas the second square will
display the boundaries of the surveyed area

If the default flight area is in an awkward location, such as in the middle
of Pacific Ocean, a series of two steps should be followed to close in on
the area of interest. First, press the GPS button, to establish the current
location, then press the reset button,
, to center the flight area on top of
the current location. Starting from the current location, the flight area can
17

be delineated. Assuming that the interest is in monitoring the stream from
the junction of the Road 6020 and Southside Slip (Figure 9), and area of
less than 10 ha would be surveyed.

Figure 9. Flight area for a polygon mission

4.1.1.1.3 Establishment of the flight parameters
The selection of the sensor and of the area to be surveyed is followed by
the selection of the parameters defining the flight itself. There are many
parameters that can be adjusted, but most of them are already filed with
preset values that are considered optimal for most flights. However, there
are several that must be chosen to meet the objective of the image
acquisition. Among those the following three are important (Figure 10):
•
•
•

flying altitude, as it defines the resolution of the multispectral
orthorectified image;
flight speed, as it will define productivity and the quality of the
image;
side overlap, as it will ensure that the flight lines are aligned
properly.
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Figure 10. Flight area with the flight parameters: altitude 60 m above the starting point, fast speed,
and 80% side overlap.

The default altitude is 50 m, which for the Mavic2 Pro sensor would lead
to a 1.17 ground sample distance, or each pixel at nadir corresponds to a
1.17 cm on the ground. If the flight altitude is too low, then the pilot can
decide to increase it, in this example to 60 m (Figure 10). The speed of the
UAS was set to the maximum speed allowed whereas the side overlap was
left to 80%, which is the common value for image reconstruction from
UAS images. The rest of the settings, were left unchanged, as it fit the
land monitoring objectives.
After all the parameters where chosen, the mission should be saved, which
is done by pressing the floppy disk button. A summary of the mission is
displayed (Figure 11), such that the pilot have the option to review it and
change it if needed.
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Figure 11. Flight plan summary

To start the flight in the field, open the mission, then press
,
which will trigger the connection with the UAS. If the UAS is not turned
on, or the mobile device is not connected with the flight controller, then an
error message will appear (Figure 12).

Figure 12. Message announcing issues with the start of the flight.
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The main limitation of Pix4Dcapture is that the flight plan is not adjusted
to the morphology of the land, meaning the UAS will fly at a constant
elevation. To avoid obstacles, the unit will have fly at high elevations,
which will make the subsequent image rendering suboptimal. Therefore
more proficient software should be used, such as UgCS or Drone Deploy.
4.1.1.2 Mission planning with DJI Pilot
DJI produced multiple flight planning software through time to support its
fleet of UASs. However, the weakness of its approach is the lack of
support of old controllers in the new mission planning versions. Evermore,
some packages, such as DJI GO or DJI GO 4, have no mission planning
abilities, which confuse the users. Nevertheless, there are packages that
help plan a mission for newer platforms, such as DJI Pilot, which is
presented succinctly in the following sections. Similarly with
Pix4Dcapture, DJI Pilot is also a mobile device only app, therefore the
entire mission is planned using a tablet.
4.1.1.2.1 Selection of the flight controller
Because the DJI Pilot supports only few UAS (at the time of writing the
manual only Mavic 2), the selection of the flight controller is not an issue,
as the unit either will connect with the tablet immediately or the plan is not
suitable for the respective platform (Figure 13). However, as we will see,
there are multiple sensors available, including a custom build option.

Figure 13. Connection of the DJI Pilot with the application
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4.1.1.2.2 Selection of the flight path
Irrespective of the connectivity to the UAS, there is only one option of
mission plan: the snake type (Figure 13- right). This means that any
variation from the preset plan must be adjusted by careful calculation.
Fortunately, the snake like pattern is by far the most popular land survey
approach. Therefore, the Mission flight icon should be chosen.
4.1.1.2.3 Delineation of the surveyed area
Once the flight pattern was chosen, DJI Pilot will open a new window that
will help define the area to be surveyed. There are two options: manual or
by using a kml file. Obviously the preferred option would be through kml,
because the area of interest can be clearly delineated on Google Earth on a
large screen at the office. Unfortunately, the kml option at the time of
writing the manual was not functional. Therefore, again, the only option
available is to identify the area manually by selection the Create a Route
option

.

As soon as Create a Route option is chosen, a rectangle, centered in GPS
location of the tablet, will appear overlaid on a map (Figure 14-left),
currently supported by mapbox.

Figure 14. Default area after the Create a Route option is pressed (left) and its initial location
(right)

In most instances the default area created by DJI Pilot would be positioned
in an undesired location, possibly far from the current place of the tablet
(Figure 14-right). To navigate to the desired area, first the default region
should be delated, otherwise it is difficult to drag the corners of the default
area to the place of interest. The default area is deleted by simply pressing
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the
icon. Once the default area is deleted, the next step is to zoom out
the map and identify the coarse region where the flight should be executed
(Figure 15).

Figure 15. Zoom out on the region to locate the area where the flight should be executed

A nice feature of the DJI Pilot is the display of the restricted areas, which
depending on the color shows the flight class zones. The darker the color
the more restrictive the class zone is. Once the flight area is identified, by
zooming in / out and panning (), the boundary of the area to be survey
should be placed on the map. To achieve this task, a simple tap and hold a
finger on the screen for 1 sec would create a new rectangular area (right).

Figure 16. Course identification of the region where the flight would be executed (left) and the
creation of the default flight area in the proximity of the area to be surveyed (right).

Assuming that the same region at the intersection of the 6020 Road and
Southside Slip is of interest, as it was for the Pix4Dcapture, the actual
boundaries of the flight area are created by adjusting the corners of the
initial rectangle (Figure 17-left)
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Figure 17. Creation of the flight area from the default area (left), and zooming in on the area
(right).

The flight lines and the waypoints can be seen by zooming in on the flight
area, particularly when overlaid on the imagery (Figure 17-right). At this
point, it is advisable to save the mission plan, which is executed by simply
pressing the floppy-disk button.
4.1.1.2.4 Establishment of the flight parameters
The last step in completing the mission plan is to set the flight parameters,
particularly the elevation, speed, and the overlapping between side lines.
Given the sensor, all the details are automatically computed (Figure 18).

Figure 18. Selection of the sensor
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For example, if the sensor is the Phantom 4 camera, then a flight at 80 m
elevation (Figure 19-left), leads to a flown distance of 4118 m and 20
waypoints. However, for the same camera, a side overlap of 70% and a
frontal overlap of 80% would record 211 images, whereas the same side
overlap but a frontal overlap of 85% would record 278 images (Figure 19right).

Figure 19. Selection of the flight parameters: sensor and flight altitude (left) and image
overlapping (right)

Similarly to Pix4Dcapture, DJI Pilot does not adjust for elevation, which
is probably the largest draw back of the platform, beside the limited
number of controllers for which the app can be used.
4.1.2

Informing FAA

Almost all UAS missions are prepared by the pilot in command,
sometimes referred to as the Remote Pilot in Command, or RPIC
(Division of Aviation, 2017; Martin, 2018). Because the UAS requires less
knowledge on piloting than a manned aerial vehicle, the RPIC not only
that usually has the knowledge on how to maneuver the flying system but
also is intimately related with the project for which the flight is executed.
Therefore, after the mission is planned, the RPIC is responsible for
ensuring that all the rules and regulation governing the usage of UAS
under the 14 CFR Part 107 are fulfilled. There are several tasks that must
be completed such that not only the data is acquired according to the
expectation, but also the laws are adhere to.
The first task, occurring immediately after the mission plan is completed is
to inform the FAA of the intention to fly, if the flight is executed near
airports or a waiver is needed. However, most land monitoring flights
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occur far from airports and does not require a waiver, which means that no
prior approval from FAA is needed.
4.1.2.1 Fly in a controlled airspace: Low Altitude Authorization and
Notification Capability
In case that the Part 107 requirements are not met because the flight is
carried in a controlled airspace the RPIC must obtain permission from
FAA. If the flight is executed under the umbrella of a larger organization,
such as a university or a UAS specialized company, then there is an entity
that will file the required documentation to FAA. However, if the flight is
executed by a person that operates UAS occasionally, then the
documentation required by FAA must be submitted by the individual
directly to the FAA. Irrespective of the size of the entity carrying out the
UASS flight, the FAA requires an approved application for airspace
authorizations. To streamline the process a collaboration between
government and private industry that facilitates the sharing of airspace
data was created, called Low Altitude Authorization and Notification
Capability (LAANC). LAANC supports direct integration of the UAS
flights into the airspace, such that not only the pilots have access to the
control airspace below 400 feet but also the air traffic professionals know
where and when the UAS are operating. In essence, the LAANC
streamlines the application and approval process for authorizing the usage
of the airspace. Once the request to fly with a small UAS (as defined by
the FAA) under 400 feet is submitted on LAANC, multiple data sources
are queried, including the Temporary Flight Restrictions (TFRs) and the
Notices to Airmen (NOTAMs). If no issues were found, the authorization,
called Authorization User Code, is provided in term of minutes.
Furthermore, the RPIC is not required to notify the air traffic control tower
before they fly, except when specifically stated in the authorization
granted through LAANC. However, the RPIC is responsible for checking
the NOTAMs immediately prior to the flight.
The most common avenue to submit an application for flying a UAS
through LAANC is using internet. A series of companies are authorized by
FAA to provide LAANC services
(https://www.faa.gov/uas/programs_partnerships/data_exchange/).
However, LAANC is not available country wide, only to approximately
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400 air traffic facilities, which covers around 600 airports. In eventuality
that the area for which the UAS fly is intended to is in the controlled
airspace of airports not offering LAANC, then a manual process for
applying for an authorization is available. Irrespective of the application
type, manual or internet, the information required is the same, and is focus
on two aspects: the flight area and the flight details. The boundary of the
area is usually drawn on a map that covers the entire planet, such that
Google Maps or Bing Maps. The flight details are almost all based on the
mission plan, such as the type of UAS, the UAS registration number, the
flight altitude, and the RPIC Part 107 Certificate. However, other
information is needed, particularly the one related to the proposed flight
dates and times. Many LAANC applications have a friendly user interface,
such as the one supported by AirMap. Some applications require
information on the expected status of weather during the flight. The RPIC
could use the FAA resources to obtain accurate weather data, such as the
Meteorological Terminal Aviation Weather Reports (METARS) or the
Terminal Area Forecasts (TAF). The latest and most current information
on the weather conditions, the NOTAMs, and the Temporary Flight
Restrictions, can be acquired by the RPIC by visiting the
www.1800WXBRIEF.com or calling 1-800- WXBRIEF.
4.1.3

UAS preparation for flight

Before the departure to the field to execute the flight, the RPIC should
conduct a throw inspection of the UAS. A good practice is creation of a
list that is constantly checked before leaving the facility. According to the
North Carolina Division of Transportation (Division of Aviation, 2017),
the minimum inspections that must be carried out before field departure
are:
•
•
•
•

Check documentation: Pilots Certificate, Aircraft Registration,
UAS Manual, Insurance.
Check emergency contacts: phone of the nearest air traffic control,
insurance agent
Check the airframe for signs of damage or advanced wear and tear;
Check the entire aircraft according to the manufacturer
specifications, particularly ensure that the UAS is in good
structural condition and no parts are damaged, loose, or missing.
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•
•
•
•
•
•

Check the propellers for damages, deformations, or looseness
Check if all batteries are fully charged.
Check the functionality of the remote controller and its battery
status
Check the camera and its mounting systems.
Turn on the aircraft without the propellers and check the aircraft
response to the controller movements.
Repair or replace all the parts found unsuitable for flying in the
above checklist.

In the field, the RPIC must confirms that the start and end of the flight
occurs at safe locations. The RPIC must familiarize with the surroundings
before the take off and document the preflight conditions. It is
recommended that a Pre-Flight Report is formally developed and
completed. The pre-flight report must include a pre-flight checklist that
should contain, but not limited to, information on the following aspect of
the flight:
•
•
•
•
•
•
•
•
•

•
•
•

Check availability of the required documentations and emergency
contacts
Establish whether or not the weather conditions are safe to fly;
Check air frame for damages and deformations
Check if all screws are tight.
Check if the propellers and the Rotors are not damaged and tight.
Check if the batteries are fully charged and securely mounted.
Check the communications between the controller and the UAS.
Check mission flight plan
Check if the existence of security switcher on the remote controller
for the “Return Home” and “Emergency Landing” as well as their
proper loading.
Check if the “Return Home” and “Emergency Landing” locations
are located appropriately
Check the sensors requirements and verify if the right setting is
loaded.
Brief the flight crew on the duties and responsibilities
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4.2 Flight operations
As stated previously, the most dangerous part of land monitoring is the
flight itself. The entire responsibility fall on the RPIC; henceforth, the
emphasis on preparation and execution of the flight. During the flight the
RPIC and the flight crew must:
•

•
•

fly according to the mission plan, therefore launch, operate, and
recover from the preset locations if the ground matched the aerial
imagery. Small adjustments, particularly on the take-off and
landing locations, are possible.
have a clear view of the aircraft at all times
inform the pilot of any possible flight hazards during the flight

In eventuality of an accident during the flight, the RPIC should put all the
efforts in recovering the aircraft.

4.3 Post-flight operations
4.3.1

Uneventful flight

After the UAS has landed, the RPIC must inform the flight crew that the
flight is completed. If multiple flights are executed one after each other,
mainly because of battery swap, the RPIC should inform the flight crew
every time when the vehicle lands and take-off. After each landing, the
RPIC must:
•
•
•

•
4.3.2

Shut down the UAS and disconnect the batteries
Visually check the aircraft for damages
If there are multiple flights, ensure that there is enough memory
available on the camera, and transfer the data from the camera to
the backup storage device. If there is one flight, ensure that the
images from the camera are the backed-up or transferred on the
storage device
Record the flight time and other flight details in the flight log
Emergency procedures and accident reporting

4.3.2.1 Emergency procedures
Every UAS flight has a chance of failing, in the sense that either a
mechanical, electrical or communication issue can arise while the vehicle
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is in the air. Therefore, emergency procedures should be in place. The
most important person during the flight is the RPIC, which should do
everything to avoid split-second decisions and emergency situations. The
RPIC must be prepared to execute any procedure deemed as necessary
when the connection with the aircraft is lost, the GPS exhibits signal loss,
or other aircrafts or obstructions suddenly appears. Besides the ability to
pilot the UAS, the RPIC have to inform the flight crew before the flight
starts on the emergency procedures, as well as where the landing site is, in
case of emergency.
Special procedures should be developed for a loss-of-link or fly-away
case. A fly-away occurs when the UAS does not respond to the RPIC
commands and flies out of the area planned for surveying. A fly-away
event can have disastrous consequences and requires immediate actions.
The emergency starts while the UAS is still in the air, and triggers a
sequence of actions (Martin, 2018):
•
•
•

•

•

The RPIC informs the flight crew about the emergency
The RPIC issue the “return to home” command and continues to
issue the command in case the aircraft responds.
The RPIC records the time then the control loss occurred, the
available fuel at that moment, the heading and altitude of the
aircraft.
The flight crew will attempt to maintain the UAS in sight by
following the aircraft on foot. Chasing the fly-away UAS on foot
or with a vehicle is prohibited.
The RPIC must determine if the fly-away will be hazardous by
considering the location of the surveyed area, the nearby airspace
and infrastructure (e.g., refineries or electric substations). If the
RPIC determine that the fly-away UAS can enter a controlled
airspace, the local air traffic control center must be contacted
immediately. When the fly-away UAS could injure a person, the
RPIC must contact 911.

After the emergency response concluded, the UAS must be recovered.
Therefore, a Downed Aircraft Recovery Plan should be created before the
flight is executed. A detailed presentation of on a Downed Aircraft
Recovery Plan process and procedures is presented by Martin (2018),
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which includes three general rules and multiple specific procedures. The
three rules of Downed Aircraft Recovery Plan as stated by Martin (2018)
are:
Rule #1: No attempt should be made to recover a downed UAS located in
a hazardous area.
Rule #2: A downed UAS on privately property cannot be recovered
without prior consent.
Rule #3: Government-owned fenced areas require approval from the
responsible governmental agency before a downed UAS can be recovered.
The ensure consistency, some states developed an Emergency Checklist
(Figure 20).

Figure 20. Example of an Emergency Checklist developed by the NC Department of Transportation
(Division of Aviation, 2017)
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4.3.2.2 Accident reporting
In the eventuality than an accident occurred during the data acquisition
with the UAS, the RPIC must notify the FAA within 10 calendar days
after an accident (as defined by regulation). Even more, no flights can be
executed by the RPIC until the accident is reported. It is important to
know the specific definition of an accident, which according to FAA is an
event that cause
•
•

death or serious injury to a person, or
damage to any property, other than the small UAS, if the cost is
greater than $500 to repair or replace the property.

An UAS accident can be reported online on the FAA website. The
accident report must include:
•
•
•
•
•
•
•

the name, contact information, and the FAA airman certification
number of the RPIC;
the UAS registration number;
the location of the accident:
the date and time of the accident;
the Person or persons injured and extent of injury, if known;
the property damaged and extent of damage, if known; and
a short description of the event

5 Images acquisition and processing
The most common approach of acquiring images for land monitoring with
UAS is using a flight plan. The flight plan serves two purposes: first, to
ensure that the entire surveyed area is covered, and second, to ensure that
the images acquired will produce the desired results. Very rare a flight is
executed in a “manual mode”, meaning that the pilot is controlling the
flight path and data acquisition, as the trajectory will be far from optional
and to many or two few images will be captured. Images acquired with
manual flight mode will waste a significant amount of time in the field and
at the office. Therefore, in this material the focus will be in flight planning
using a preset path, which is designed to produce orthophotos.
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5.1 Cameras, Sensors, Lenses, and Image calibration
5.1.1

Cameras

The most popular method to acquire information for land monitoring is
using cameras. For education or commercialization purposes, cameras are
grouped in different classes. Depending on the classification criterion,
there are many types of cameras, sometimes labeled as camera models.
The most common classification system of the cameras is concerned with
the spatial distribution of light rays that provide energy to the sensor.
From this perspective, the cameras are central camera models, which have
a single center through which all rays pass, or non-central camera models,
which do not possess a single optical center. Most cameras are central
camera models. The non-central models are more complex, as the backprojection operation delivers the direction and the position of a camera,
whereas the central models supplies only the direction of the ray. There
are two non-central cameras that are encountered in practical applications:
oblique cameras and axial cameras. Oblique cameras are cameras where
two rays never meet, whereas axial cameras present a line that intersects
all rays. A special case of non-central axial cameras is the linear push
broom cameras, encountered in many applications, particularly to sensors
installed on satellites or airplanes.
A second classification system is concerned with the parametrization of
the image area. From this perspective there are two types of models:
global models and local models. A global model is a camera with a small
set of parameters, each influencing the projection across the field of view.
A local model has multiple sets of parameters, each set being dedicated to
a particular area of the image. An extreme case of the local models are the
discrete models, where the projection varies at every pixel.
The third classification that is presented in this document is focused on the
ability of a camera to express a projection directly. From this perspective
the cameras can be separated in three classes: forward projection, backprojection, and both. The last classification is important when using UAS
for land monitoring because each projection is focused on a particular
aspect. The forward projection is suitable for correcting the image
distortion and ray bundle adjustment, whereas the back-projection is
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appropriate for various structure-from-motion tasks, which is the main tool
used to produces orthorectified images presented in the document.
5.1.2

Sensors

The advancements in material sciences lead to the development of
multiple sensors recording information that can be used to represent the
environment. The vast majority of the sensors used in today cameras are
silicon based and fall under the category of either CCD (charged coupled
device) or CMOS (complementary metal–oxide–semiconductor). The
technical differences between CCD and CMOS are not relevant to this
document, what is relevant is the wavelength that can be recorded, which
for both of them is from 350 nm to 1050 nm (Figure 21). Therefore, most
cameras used to monitor the landscape operated in the visible and near
infrared spectrum.

Figure 21. Spectral sensitivity of the CCD and CMOS sensors compared to the human eye
(Bandara, 2011)

Today cameras are multispectral, and record at least three bands, usually
red-green-blue. However, for vegetation monitoring the most important
wavelength are outside the visible range, particularly in the near infrared
region of the spectrum (Figure 22), where the CCD and CMOS sensor are
most sensitive.
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Figure 22. General spectral reflectance of vegetation (adjusted from (Lillesand and Kiefer, 2007)

The most common sensor used for land monitoring contains four bands
(i.e., green, red, red edge (680 nm-730 nm) and near infrared (800 nm1000 nm)). Some images are recorded raw, or as the sensor capture the
land (such as Parrot Sequoia - Figure 23 left ), whereas some photos have
some indices computed, such as Sentera Quad Multispectral Sensor
(Figure 23 right), which computes NDVI or NDRE indices of the captured
land.

Figure 23. Multispectral sensors with four bands. Parrot Sequoia (left) and Sentera Quad
multispectral sensor (right)

More sophisticated sensors have more than 4 bands, the most affordable
one being RedEdge by MicaSense (Figure 24), which has five bands: red,
green blue, red-edge, and near infrared.
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Figure 24. Rededge Micasense sensor with five bands (red, green, blue, red edge, and near
infrared)

Besides sensor ability to record the energy of various wavelengths another
parameter that is important in describing the landscape is the ability of the
sensor to discriminate small objects, namely the spatial resolution. The
spatial resolution of today’s sensors is characterized by the size of the cells
recording the reflected wavelength energy; the smaller the cell, the more
able the sensor is to capture details. However, smaller cells have the
disadvantage that they require more light to record information. Therefore,
in selecting the sensor, one should consider the environment on which the
sensor would operate. Nevertheless, irrespective of the size of the
recording cell, for accurate and precise description of the landscape a
minimum number of cells are needed. Because the recording cells are
arranged in an array, the common word used to describe a cell is pixel,
because the information recorded by each recording cell is stored in a
pixel. Most software that produce orthorectified multispectral images from
UAS platforms requires images with sufficient resolution, which
surprisingly, is relatively low. For example Agisoft requires images with 5
million pixels, hence 5 million recording cells, for obtaining acceptable
results. Therefore, in this material it is assumed that the images are
captured with a spatial resolution above the threshold imposed by the
software used to create the multispectral orthorectified image.
5.1.3

Lenses

The camera classifications are focused on the relationship between the
image formation on the sensor and ray distribution. However, the
information stored in the light reaches the sensors through the lenses.
Similarly to cameras and sensors, the lenses can be classified according to
many criteria. One of such criteria that will be use throughout the
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document is related to the ability of a lens to produce images that appear
to be normal to a human eye. The main parameters representing the
normality of an image is the angle of view, also encountered in the
literature as the field of view. The field of view is the angular extent that is
captured by a camera (Figure 25). The field of view is usually measured
by three angles, called horizontal, vertical and diagonal, depending on the
direction on which the angle is measured. A normal lens is defined to be a
lens that has a field of view of approximately 1 radian or 57.296°. For
example a 24 × 36 mm sensor with a horizontal field of view of 1 rad has
a focal length of 33 mm, whereas a vertical field of view has a focal length
of 22 mm. The 35 mm and 24 mm are consequently some of the most
popular lenses encountered.

Figure 25. The three angles measuring the field of view (from (Ngo et al., 2019))

From a field of view perspective, the cameras are separated in three
classes: normal, wide –angle lenses and long-focus lenses. As previously
stated, normal lenses, sometimes called standard lenses, have the field of
view close to 1 radian, more specifically between 40° - 62°. Wide –angle
lenses are lenses with a field of view larger than 64°, and themselves are
separated in three subclasses: wide angle lenses (64° - 84°), ultra-wide
angle lenses (84° - 114°), and fisheye lenses (close to 180°). The long
focus lenses have the field of view less than 35°, and are commonly
separated in two subclasses: medium telephoto (10° - 30°) and supertelephoto (1° - 8°). In most land monitoring applications, the wide angle
lenses are preferred, particularly the ones close to the normal lenses, as
they provide a larger coverage without introducing to much distortion in
the image. Furthermore, wide-angle lenses mounted on central cameras
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have the sensor closer to the center, which means that more light reaches
the sensor, therefore more energy is recorded. Last but not least, the best
images are the ones captured with lenses that have a fixed focal length.
Zoom lenses should be avoided in land monitoring using UAS.
5.1.4 Settings, Lens and Sensor calibration
To ensure that that the photos recorded by the UAS can be used to produce
orthorectified images, the photos should be acquired following a strict set
of rules. For clarity of the presentation the rules are separated in two
categories: equipment settings and calibration of lenses and sensor, even
though both of them refer to the hardware.
5.1.4.1 Equipment settings
As it was mentioned before, the equipment used to capture images should
have a sensor of at least 5 megapixels, the lenses should have a fixed focal
length and with a normal or wide-angle field of view. Besides these three
conditions, there are several camera settings that should be implemented.
First, the images should be recorded using an uncompressed format, such
as RAW or TIFF, as compression could introduce noise inside the image.
Second, the sensor ability to capture images should not be hindered by
size reduction; therefore, the images should be always recorded at the
maximum possible spatial resolution. Third, the sensor ability to record
radiation, should not be impaired by sensitivity settings; therefore, the
camera should always use the lowest ISO, such that additional noise
would not be added to the image. Lastly, to ensure that enough radiation
reaches the sensor, the aperture value and the shutter speed should be such
that the images are captured with no blur. Therefore, the shutter speed
should be high enough to avoid blur but slow enough to allow for the
largest aperture value possible, such that the sensor is not restricted by the
milted amount of energy received. In summary, the following settings
should be enforced:
• Use sensors with at least 5 megapixels;
• Use lenses with fixed focal length, normal or wide angle field of view;
• Use uncompressed images, such as RAW or TIFF;
• Use the maximum spatial resolution of the sensor;
• Use the lowest available ISO;
• Use the fastest shutter speed that ensures an aperture wide enough to
provide enough energy to the sensor.
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5.1.4.2 Lens calibration
In many situations a calibration of the lens matrix, particularly the nonlinear distortion coefficients can be executed. Many software packages,
such as Agisoft, calculate the calibration parameters during the production
of the orthorectified image. However, in instances when the image
alignment is difficult, the lens calibration can help identify the tie points
between images. A set of six parameters are commonly estimated during
lens calibration: 1) the focal length measured in pixels, 2) the principal
point coordinates (i.e. coordinates of the optical axis of the lens expressed
in pixels inside the sensor plane, 3) the affinity and skew transformation
coefficients, 4) the radial distortion coefficients, and 6) the tangential
distortion coefficients. Many packages are available for calibrating the
lenses, but for this document Agisoft Lens is used. Agisoft documentation
material explains all the steps in great detail, therefore, we will summarize
the information relevant to this document.
The calibration pattern is commonly either a LCD screen or a printed
chessboard pattern that is flat. The following successions of steps uses the
LCD screen as a calibration pattern. The lens calibration process start by
opening the software Agisoft Lens, which can be downloaded from
various websites, such as cnet.com or zdnet.com.

Once the Agisoft Lens is opened select the Show Chessboard icon or the
Show Chessboard from the Tools menu:
the screen into a chessboard.

. This would turn
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To ensure that enough squares are used for calibration zoom the pattern
such that more than 10 squares are on each side of the screen. Once the
number of squares is ensured, at least 3 photos of the displayed calibration
pattern should be captured with the camera from slightly different angles.
The images of the calibration pattern should contain the entire pattern and
be captured without glare. Once the pictures of the calibration pattern are
captured, press Esc to exit the screen display of the chessboard, and load
the images in a new Chunk:
. Once the images are loaded they
should be displayed in the Photo pane
showing the files under the chunk,
whose name would be the f value, in
this example f 3.83:
After the images are loaded, select
either the Calibrate icon,
, or navigate to Tools -> Calibrate, which will
open the calibration window. There are six parameters that can be
calibrated:
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If the decision to calibrate the lenses is taken, then all the parameters
should be selected for calibration. After OK is pressed, a new window

displaying the status of the calibration will appear:
Once the calibration is completed the results will appear in the Report tab.

The newly calibrated values can be saved by selecting File, then Save
Calibration:
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The saved lens calibration values can be used now in the process of
producing orthorectified images. To ensure that the calibrated values are
used during the alignment process and not the refined ones that are
computed during Align Photos step, the Fix option in Agisoft from the
calibration box on the Initial tab of the images subject to be processed
should be checked. A similar approach to ensure that the calibrated values
are used during the alignment stage should be implemented in other
packages, not only in Agisoft.
The latest version of Agisoft, namely Metashape, has the Lens calibration
built in. The process is similar with Agisoft Lens, but now can be accessed
through the Tools → Lens menu.

5.1.4.3 Sensor calibration
The sensor records the radiation that reaches it. However, in many
instances the radiation reflected by the ground is not the same as the
radiation that reaches the sensor. Therefore, a radiometric calibration is
needed in many instances. Radiometric calibration considers relative
position of the sensor in respect with the sun, the irradiance
measurements, and the gain and exposure of the camera. The radiometric
calibration allows conversion of digital numbers recorded by the sensor to
the surface reflectance values. The main advantage of radiometric
calibration is the production of repeatable reflectance values among
different flights, dates, and weather conditions. Images that are not
radiometric calibrated can produce results that presents obvious artifacts:
•

Some images would be underexposed images, especially in areas
with bright objects that tend to saturate the image
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•
•
•

An irregular coloration is present throughout the image
Some remote sensing indices, such as NDVI or GVI, change
dramatically and unexpectedly on short distances
The orthorectified images presents bands or patches that do not
exist in reality

The present manual presents the radiometric calibration using
Agisoft Metashape Professional 1.5 for the Micasense
RedEdge MX sensor. The Rededge MX is a synchronized 5bands sensor with a field of view of 47.2 °, developed for
advanced remote sensing. The recorded wavelengths have
different band widths, 10 nm for red (668 nm), red-edge (717
nm), 20 nm for blue (475 nm) and green (560 nm), and 40 nm
for near –infra red (840 nm). Each band captures RAW images with 12
mega pixels resolution at 12 bits depth.
Each Micasesnse Rededge camera comes with a calibrated reflectance
panel, which will be used to radiometric correct the images (Figure 26).
The calibration panel is very important for producing consistent results,
therefore it is shipped inside a ruggedized case (Figure 26 left). Each
sensor has a corresponding calibration reflectance panel comes that is
identified by a QR code (Figure 26 right), located besides the calibration
panel itself.

Figure 26. Calibrated reflectance panel for MicaSense Rededge: outside case (left) and the actual
panel with the QR code (right)

Before the flight is started, the calibrated reflectance panel is laid on the
ground, in an area that is horizontal and visible by the sensor while in the
air (Figure 27). The presence of the QR should ensure that the calibration
images are automatically recognized by Agisoft during processing.
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Figure 27. Calibrated reflectance panel for MicaSense Rededge as recorded by the sensor. The
color of each image is the panchromatic representation of each recorded wavelength (from (Sa et
al., 2018))

The reflectance calibration process is implemented in Agisoft as a part of
the workflow aiming at producing orthorectified multispectral images.
Therefore, the first step is to upload the images recorded by the sensor,
including the ones containing the calibrated reflectance panel. Because
each wavelength is stored in a separate image, the multi-camera system
option should be chosen (Figure 28).

Figure 28. The first step in uploading the multispectral images acquired with MIcaSesnse RedEdge
sensor

Agisoft Metashape Pro identifies the calibration images automatically and
places them in the special camera folder if the metadata of each image
specifically mentions calibration (Figure 29). The images recognized as
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calibration images will not to be used in the creation of the orthorectified
images.

Figure 29. The window announcing that the calibration images were moved to the special
calibration folder

When the images metadata does not contains the calibration information,
the calibration images will be identified by manually selecting them. The
detection of the calibration images starts by indication the location of the
images with the calibration panels, which is simply by accessed by
opening the Tools Menu and choose Calibrate Reflectance option,
followed by choosing the “Locate Panels” button (Figure 30).

Figure 30. Manual selection of the calibration reflectance panels

The images containing the calibration panel that are identified will be
moved to a separate folder. Each image will be masked such that only the
panel itself is visible. An additional step is required when the panel is used
for the first time, since the calibration is not loaded inside the Metashape
Pro (Figure 31).

Figure 31. The windows requiring the csv panel calibration file to be uploaded (image from Agisoft
Helpdesk Portal).
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Therefore, calibration parameters, which are stored in a csv file from CSV
file should be uploaded inside Agisoft. If the csv file with the calibration
information is missing, two approaches are available. The first approach is
by imputing the calibration values manually. However, the second
approach is simple and uses the downloaded csv file from the MicaSense
website https://www.micasense.com/prv, which are specific to each
calibration panel. The serial number identifying the calibration panel is
found above the QR (Figure 26-right). After the csv file is uploaded, the
calibration reflectance process is almost ready to be executed (Figure 32).
However one last option should be selected, and is related to the choice of
including or not the sun sensor. Micasense recommends that if the images
are acquired during a sunny day, then use only the reflectance panels,
whereas if the flight is carried out during an overcast day then use both the
reflectance panels and the sun-sensor (abbreviated DLS - Downwelling
Light Sensor). Once the choice of using the sun-senor or not is
implemented, press OK and the calibration is executed.

Figure 32. Reflectance calibration interface ready to be executed

Once the calibration is completed the announcement that the creation of
calibrated orthorectified multispectral images can start will be printed:
- - - - Proceed with the data processing - - - - -
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5.2 Production of orthorectified images
In most instances, the final product of an image acquisition with UAS
focused on land monitoring is an orthorectified multispectral image with
high spatial resolution (i.e., at most 5 cm). However, the complexity of the
tasks involved in the production of the orthophotos depends on the
surveyed area. Therefore, if the UAS flies over crops with limited
variation in elevation, such as grasses, then a simpler procedure would
create high quality orthophotos, whereas if the crop exhibits highly
textural surfaces, such as forest, then a more complex procedure is needed
to obtain orthophotos of sufficient quality. The complexity of the
procedures is not related to the content, as the same steps are used in both
situations, but to the intensity of each step. From this perspective low
textural surface could need only one or two iterations of a particular step,
whereas high textural surface could require more iterations (Figure 33).
A landscape with reduced texture is considered a landscape that contains
large areas with limited vertical variability and reflectance within a narrow
range of wavelengths. For example a golf course or a flax plantation are
surfaces with reduced texture. When the land to be monitored is covered
by several homogeneous areas with limited variability, the processing is
simpler, particularly in terms of GCP identification. A landscape that
exhibits large variability in terms of elevation and reflectance is
considered a highly textured landscape. A forest or a large urban
development with an intimate mixture of building and vegetation is a
highly textured environment. Nevertheless, the same steps are presents,
regardless the texture of the landscape.

Figure 33. Landscapes with different textures (from Google Earth): reduced (left-Illinois) and high
(right-South Carolina)
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The production of multispectral orthorectified image contains a series of
steps, executed in a particular order. Because the procedure used to
produce orthophotos is based on SfM, the steps are almost the same
irrespective of the software implementation. Among the possible software
used to produce orthorectified images, such as
Image alignment
Pix4D or VisualSfM, the present manualnt uses
Agisoft Metashape (Agisoft, 2017).
Regardless of surface texture and the package
used to create orthorectified images, the first step
is the image alignment. The alignment step is
focused on finding the pose of the camera using a
set of images. The image alignment occurs after
the reflectance calibration and starts by
uploading the images that were captured to create
the final multispectral orthophoto. In Agisoft, the
set of images that are processed using the
structure from motion (SfM) algorithm are
grouped in the so called “chunks”. Multiple
chunks can be later merged, but the initial
processing is done chunk by chunk. For surface
with low variability, sometimes called untextured, Agisoft recommends a series of eight
steps (Figure 34) , some optional, to produce the
orthorectified multispectral images (Agisoft
Helpdesk Portal): 1) photo alignment, 2) camera
optimization and gradual selection, 3)
identification of ground control points (GCP), 4)
generation of dense cloud, 5) generation of the
mesh or DEM, 6) creation of the orthophoto, 7)
calculate remote sensing indices (optional), and
8) export the data. However, before any
processing is executed the quality of the images
should be assessed. Agisoft, like any
photogrammetric software, requires good quality
images. Images, without blur, saturated or
underexposed. To assess the quality of the
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Ground Control
Points
Dense Cloud
generation
DEM or mesh
generation
Orthophoto
creation
Export point cloud
and orthophoto
Calculate remote
sensing indices
Figure 34.Steps needed to generate
orthophotos and point clouds
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images, Agisoft produces a routine that helps in establishing whether an
image is worth being included in the processing. The routine starts by
simply right clicking the selected images to be processed, then choose the
Estimate Image Quality option. Images with a quality value less than 0.5
should not be used in processing.
5.2.1

Image alignment

After the images were uploaded inside Agisoft, the first step in production
of the orthophotos consists in image alignment, basically finding the
relative position of the sensor in respect with the ground, meaning
Cartesian coordinates and the local angles of the camera
Image alignment
(i.e., pitch, roll, yaw). The photo alignment is the most
important step in the creation of an orthophoto, as
everything hinges on the success of the image alignment.
Gradual Selection
Therefore, most effort should be placed in ensuring a
successful photo alignment. The photo alignment interface
in Agisoft has several parameters that are defined by the
Ground Control
SfM process (Figure 35), the most important ones being:
Points
•

•

•

Accuracy. If the original image is used then the
accuracy is set to high. Every step downwards reduces
the size of the image by 4.
Overlapping pairs of photos. The alignment of a
large number of images takes a significant amount of
time (in many instances hours), out of which a major
period is spent on matching detected features across
the photos. Agisoft hast two modes of selecting the
features across photos: generic preselection and
reference preselection. The most common mode is the
generic preselection, where the overlapping pairs of
photos are identified by using lower accuracy setting
first. In the reference preselection mode, the
overlapping pairs of photos are selected according to
camera locations.
Number of key points. The maximum number of
feature points on every image to be taken into account
during current processing stage
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•

Number of tie points. The maximum number of matching points
located inside each photo.

The other options present in the Agisoft interface are used mostly in
special circumstances. In most land monitoring situations these options
(i.e., presence or absence of a mask or
adaptive camera model fitting) are not
present. Agisoft recommends that the
MicaSense Rededge images should be
aligned using the entire image
(accuracy set to high), with 40,000
key points and 4,000 tie points (Tagle
and Zabala, 2017). However, in many
situations, it was proven that larger
values for key points and tie points
are preferred. (Maturbons et al., 2017)
suggests that more than 100,000 key Figure 35. Parameters for alignment of the
multispectral images acquired with the
points and 40,000 tie points should be Micasesne RedEdge.
used for accurate alignments.
After the photos are aligned, the results are shown in the Model view,
which also shows the cameras at the correct location (Figure 36). The
main output of the camera alignment is the tie point cloud, also shown in
the Model view (Figure 36). You should remember that the tie points are
matching points between images.

Figure 36. Aligned images and the tie points. The blue rectangles represent the location (x, y, z)
and orientation (pitch, roll, yaw) of the cameras.
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Not all the tie points would be used in the creation of an orthophoto, as
some are erroneously located. To select only the useful tie points, Agisoft
displays a rectangular box that defines the region of interest. The size and
location of the box can be adjusted manually using three options: move,
rotate and resize. The manual adjustments can be accessed through the
Menu Bar under the Model → Transform Region or directly from the
Toolbar (Figure 37):

Image alignment

Gradual Selection

Figure 37. Selection of the option to change the region for which the dense
point cloud and the oprthophot would be created.

5.2.2

Ground Control
Points

Camera optimization and gradual selection

The accuracy of the image alignment can be improved by
optimizing the cameras, which would override the interior
orientation parameters with the values that are fit according
to the recorded images. Camera optimization is similar to
lens calibration, but is mutually excusive, in the sense that
only one can be used: either the parameters estimated
during the lens calibration process or the values that were
computed by the Optimize Cameras option. In most
instances the Optimize Cameras option is preferred, as it is
a natural step during the workflow and it is fully contained
within the same platform (i.e., does not require additional
software). The Optimize Cameras option is accessed from
the Menu bar by Tools →Optimize Cameras (Figure 38):
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Figure 38. Optimize cameras interface is used to improve the accuracy of images alignment

In most practical applications, estimation of the point covariance is
irrelevant as it is not used for subsequent processing. However, the
adaptive camera model fitting could be an option to consider, as it enables
automatic selection of the parameters according to their reliability. By
default, Agisoft would not use the adaptive camera model fitting, which
means that only the fixed set of parameters, namely the focal length,
principal point position, three radial distortion coefficients (K1, K2, K3)
and two tangential distortion coefficients (P1, P2), would be optimized.
However, many UAS acquisitions exhibit weak camera geometry, which
can be improved by the adaptive camera model fitting option that prevents
divergence of some parameters.
In the eventuality that the camera orientation parameters used for image
creation were estimated outside Agisoft Metashape, they can be imported
inside the computation platform through the File menu (Figure 39):
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Figure 39. Uploading the camera orientation parameters from outside sources, such as Agisoft
Lens

The 3D reconstruction from photos contains many erroneous points.
Therefore, there are tie points created during the image alignment that are
not correctly positioned (Figure 40), which should be eliminated.

Figure 40. Identification of some tie points that can be inaccurately located
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There are four procedures that can be used to
eliminate the wrong tie points, which can be
accused through the Model from the Menu bar.
The four available procedures can be accessed
by choosing Gradual Selection from the Model
menu, name that suggests a repetitive process
because the elimination of erroneous points is
implemented iteratively. The procedures are
Reprojection error, Reconstruction uncertainty, Image count, and
Projection accuracy (Figure 41). Each procedure is focused on one
criterion to filter out points.

Figure 41. The Gradual Selection procedures available for elimination of erroneous points

The Reconstruction Uncertainty is recommended for elimination of points
that are reconstructed from the photos with small baseline, which can
deviate from object surface. The removal of the points that are likely in the
wrong place will not affect the accuracy of the alignment, but it could
impact the geometry building and definitely will visually impair the point
cloud.
The Reprojection error is a procedure focused on points produced by false
matching. Removal of the points with high reprojection error will improve
the accuracy of the subsequent optimizations.
Image count and Projection accuracy are two procedures that use simple
criteria to eliminate erroneous localized points. The image count filters out
points situated in only few photos, whereas the projection accuracy
remove the points that exhibits large discrepancies in term of localization
with the rest of the points.
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Irrespective of the criterion, the erroneous points are identified using a
threshold level implemented as a sliding rule. The points identified as
inaccurate according to the threshold of a particular criterion are identified
on the point cloud. As soon as a criterion is chosen the point cloud is
analyzed, such that each point would have a particular threshold to be
included or not in the final point cloud. For example choosing the
Reconstruction Uncertainty criterion the maximum threshold is 828, in
this example. Choosing a level of 182.152 would identify all the points
that visually do not belong with the rest (Figure 42).

Figure 42. The point identified as erroneous by the Reconstruction uncertainty criterion and a level
of 828. It should be noticed that among the 154,748 points only 816 were selected as inaccurate
(less than 1%). The erroneous points are colored in pink.

If Reprojection error is used for identification of inaccurately located
points, the maximum level is 3.9, and a level of 1.85212, eliminates
16,655 points (Figure 43), even though the relative threshold is larger than
the one of the Reconstruction Uncertainty. Furthermore, there are many
points that were far from the bulk of the points that were not identified as
erroneous by the Reprojection error. Therefore, the choice of the method
to eliminate points should be tailored to the data and the project itself
rather than to a procedure or a value.
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Figure 43. Elimination of erroneous points using the Reprojection error criterion

The selected points are eliminated by simply pressing the Delete key.
After the first set of erroneous points are eliminated, the procedure is
repeated. For the Reconstruction Uncertainty case, the values now range
from 0 to 182.1, whereas for the Reprojection error from 0 to 3.9. A
threshold value of 100.176 for the Reconstruction uncertainty criterion
would eliminate 2069 points (Figure 44) whereas a value of 2.00646 for
the Reprojection error criterion would remove 11,264 points (Figure 45).

Figure 44. Second iteration of the Reconstruction uncertainty
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Figure 45. Second iteration the Reprojection error criterion to identify erroneous located points

The final results could look similar to the naked eye after the elimination
of the erroneous located points (Figure 46). However. It should be noticed
that one criterion eliminated 2985 points (i.e., Reconstruction uncertainty)
whereas the other removed 27919 points, almost one order of magnitude
larger (i.e., Reprojection error). Depending on the number of tie points and
the final objective of the project for which the orthorectified images are
produce one criterion would prevail over the other.

Figure 46. Final tie points used for densification
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5.2.3

Accurate Georeferencing

To avoid positional errors among flights ground control points (GCP)
should be collected before, during, or immediately after
Image alignment
the flight. The GCP also would ensure that the model
would not be distorted, besides positioning it correctly
on the planet. The GCP can be premade targets, such as
Gradual Selection
painted crosses or black –and-white rectangles (Figure
47). However, in many instances premade targets are not
needed, as obvious man-made structures are available,
Ground Control
Points
such as bridges or posts, whose coordinates can be easily
acquired in the field.
Dense Cloud
generation

DEM or mesh
generation

Orthophoto
creation

Figure 47. Popular GCP: X shape (left) and Checkboard (right)

The coordinates of each GCP should be acquired with a
survey grade GPS, such as Trimble Geo 7 series or Leica
Export point cloud
and orthophoto
iCON. The coordinates should be saved in an ASCI
format, either as a tab delimited or csv file. The file
should contain only three fields: lable, x (longitude), y
Calculate remote
(latitude, and z (Elevation). To upload the GCP
sensing indices
coordinates in
Agisoft, the Reference tab should
be chosen:
.
Within the Reference tab, press
the import icon (located at the top of the pane Reference pane) and point
to the ASCII file with the coordinates:
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If the coordinates are not displayed properly, then the appropriate
delimiter should be specified by choosing among the available radio
buttons. Furthermore, if the first row contains the heading of each column,
be sure that the first imported row is the second row not the first one. If
rotation angles are not available, be sure to uncheck the box specifying the
yaw, pitch and roll (Figure 48).

Figure 48. Import the GCP file and the corresponding Agisoft options

Immediately after importing Agisft will require allocation of the GCP to
markers, which forces the selection of Yes to All, from the windows
appearing after the Import csv (Figure 49).

Figure 49. Conversion of the GCP into markers
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To define the markers as GCP, the target should be located in the images.
Therefore, the GCP should be located in multiple images, then allocated to
the appropriate marker (Figure 50).

Figure 50. Allocation of the markers to GCP in Agisoft. First maker (left) second marker (right).
Note that the first maker (CP04) is not available anymore, as it was already allocated to a GCP..

As soon as the markers are identified in two photos Agisoft starts
computing where the GCP should be located in the rest of the photos.
Each photo should be inspected for the presence of the GCP, and
positioned accordingly. If the marker is located correctly then it should not
be moved. If the marker does not position correctly the GCP, then it
should be adjusted. Usually, very small changes should be needed after the
marker was repositioned in three images. Every image that has the marker
adjusted would be identified in the Photo pane with a green flag (Figure
51).

Figure 51. Identification of the images where the GCPs were adjusted
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It is recommended that the first three GCP located in the images should be
farther apart, such that the subsequent computations are more efficient. To
see all the photos on which a GCP is present right click on the marker
corresponding the respective GCP then select “Filter Photos by Marker”.
The Photo pane will show only the images where the GCP is located
(Figure 52), whether or not the GCP was adjusted inside it (i.e., with or
without green flag).

Figure 52. Identification of the photos containing only a specific marker, namely GCP (green flag
means that the GCP was adjusted inside the image)

The estimated positional error of the GCP is displayed beside the markers,
in pixels (if the coordinate system is geographic). A rough estimation of
the ground sampling distance (GSD) can be executed with the formula
GSD= flight altitude × pixel size / focal length.
If the estimated total error is less than 1 m, then it can be proceed with
image alignment. However, in many cases the error could be very small
(less than 10 cm), particularly of the flight was at low elevation (less than
25 m) with a powerful sensor (Figure 53). To estimate the error associated
with all points, the refresh button should be press every so often, to ensure
that the error is recomputed. It is recommended that each GCP should be
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placed in at least 10 images, but superior results are reached when more
than 20 images points to the same GCP.

Figure 53. Estimation of the GCP positional error

Once the error reached the desired level and each GCP was placed in at
least 10 images, it is recommended that that camera is again optimized.
This is simply executed by pressing the Optimize Camera button from the
Reference toolbar:
. In most
circumstances, for land monitoring the default options (Figure 54) are
sufficient to ensure that the subsequent computations are close to optimal.

Figure 54. Default parameters for Optimize Camera Alignment.

After completion of the GCP selection and camera calibration, the dense
point clouds can be created.
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5.2.4

Build dense point cloud

Image alignment
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Export point cloud
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Once the camera was aligned and the erroneous points
eliminated, with or without optimized cameras, the next
step in the process of creating orthorectified images is the
construction of dense point clouds. The objective of
building a dense point cloud is to produce a more accurate
surface of the landscape, which consequently would
improve the representativeness of the orthophoto.
However before a dense point cloud is constructed, the
area for which the point cloud would be built should be
clearly identified. The delineation of the area of interest is
carried out through the three movements of the box
encompassing the tie points (i.e., resize, rotate and move),
which can be accessed either from the Toolbar,
, or
from the Menu bar under the Model → Transform region.
The Build Dense point Cloud option can be accessed from
the Menu bar through the Workflow option. The interface
has two areas (Figure 55), one focused on the quality of
the point cloud and one on depth filtering and point
coloring.

Calculate remote
sensing indices

Figure 55. Options to build the dense point cloud

It is preferred to have orthophotos with high accuracy, which means that
the quality of the dense point cloud should be set to at least high.
However, denser point clouds are more computationally challenging,
therefore the densification choice should agree with the hardware abilities
and the timeline constraints. The options for building dense point clouds
are similar with the photo alignment options, with the only difference that
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the Ultra-high option corresponds to the usage of the original image
instead of high. The rest of the options, downsizes the photos,
incrementally, by a factor of 2.
Another parameter defining the construction of the dense point cloud is
the depth map of each image. SfM inherently will produce outliers among
the points, which should be filtered out. Several algorithms are
implemented in Agisoft to identify and eliminate the outliers: Mild,
Moderate and Aggressive. For most UAS situations, the Aggressive option
would produce acceptable results, because the algorithm is designed for
areas that do not contain meaningful small details. Nevertheless, the Mild
option, which is focused on maintaining important features inside the
point cloud (i.e., possible outliers), can be choose for some poorly textured
situations, such as homogeneous roofs.
In almost all situations the points should be colored, as the spectral
signature is of interest in the vast majority of remote sensing based
analyses.
The dense point cloud should look to the naked eye almost like an image
not as a discrete entity (Figure 56), which is the point cloud made form tie
points.

Figure 56. Dense point cloud

When the bands are labeled, the point cloud is displayed with the
appropriate colors. However, when the bands are not identified, the user
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has the option to switch between the wavelengths, called channels, using
the Tools menu (Figure 57).

Figure 57. Selection of the wavelength for displaying the colors

5.2.5

Build Surface mesh or DEM

The production of an orthorectified image through SfM
requires a surface model, which can be either a DEM or an
interpolated polygonal mesh. In most instances, polygonal
Gradual
meshes takes longer than DEM, but provides the details
Selection
needed for representing complex terrains. Therefore, in
most UAS based investigations it is preferred that a mesh
Ground Control
is built rather than a DEM. There are several
Points
reconstruction parameters that must be selected to produce
the mesh, some defining the general approach, while others
are focused on the details. The general reconstruction
Dense Cloud
generation
parameters are focused on the points used to create the
mesh (sparse or dense), on the type of surface (3D or not),
and on the details (the number of polygons). For aerial
DEM or mesh
generation
analyses, a 3D surface should be produced based on the
dense point cloud. Furthermore, for detailed meshes, the
largest number of polygons should be chosen; therefore,
Orthophoto
creation
the high option should be chosen. Another important
parameter in the creation of the mesh is the interpolation
mode. For accurate reconstruction, no interpolation should
Export point
cloud and
be executed, therefore the Disabled option should be
orthophoto
chosen, which will ensure that only areas that contains
dense point cloud are rendered. The default interpolation
Calculate
remote sensing
method, labeled Enabled, will interpolate surfaces within a
indices
preset circles around very dense point cloud, which could
leave some gaps within the model. To ensure that there are no gaps, the
Image alignment
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Extrapolate option should be used. For most UAS based data acquisition
the interpolation should be set to Disabled.
To view the
click the 3D
the Workplace
58), and the
will open.

mesh, double
Model from
pane (Figure
Model view

Figure 58. The Mesh created Agisoft from the dense point cloud using the largest number of
polygons

The creation of the mesh can be supplemented by building a DEM, as the
production of an orthorectified image is more efficient using DEM than
the mesh. The options defining the DEM production are similar with the
one used for mesh creation, with the difference that a projection should be
chosen. The selection of the projection type is purely at the latitude of the
person executing the tasks in Agisoft. However, it is recommended to use
the coordinate system recorded in the exif tags, which in most instances is
defined by the GPS coordinate system, namely WGS 84. The interpolation
should be set to “Extrapolated”, to ensure that the DEM does not have
gaps
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5.2.6

Build Multispectral Orthorectified Image
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The completion of the mesh or the DEM leads to the final
step in building the orthorectified image, which in Agisoft
is called orthomosaic. The term orthomosaic has a more
colloquial sense, as the orthorectified image is generated
from multiple photos, even that in fact it is only one
image. The orthorectification step requires selection of
several parameters (Figure 59). The parameters defining
the production of the image relate to the surface used as an
input, which depends on the previous steps (mesh or
DEM), the blending mode (defines the coloring of pixels),
and the pixel size. If both the mesh and the DEM are
available, for UAS based products, the DEM should be
chosen, as
they are more

Orthophoto
creation

Export point
cloud and
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computational
efficient.
However, if
only the mesh was built
available, then the DEM
option is not available. The
color blending mode is
important, as it will basically
define the orthophoto.
Agisoft recommends the
blending of the Redegde
bands should be avoided.
Therefore, the blending
should be disabled, which
Calculate
remote sensing
indices

Figure 59. Parameters defining the creation of the
orthorectified image
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means that the colors of the pixel would be the value of the pixel from the
nadir image. The two blending options (i.e., mosaic and average) assign
values to pixels according to the distance to the seamline (i.e., Mosaic) or
averaging the pixel’s individual images (i.e., Average). A note on pixel
size: the value from the Orthomosaic interface shows the smallest pixel;
therefore, changing it to lesser values would not improve the
reconstruction.
The orthorectified image can be viewed in the Ortho tab inside Agisoft
(Figure 60). The 3D model view is seem on the same tab with the point
cloud; therefore, only one option is available for displaying at a time:
either points of mesh.

Figure 60. Orthorectified image
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5.2.7

Save the Multispectral Orthorectified image

Image alignment

Gradual
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The orthophoto can be exported as a tiff file using the either
the Menu bar (File →Export → Export Orthomosaic) or by
right clicking on the Orthomosaic on the Workspace pane,
then choose Export Orthomosaic (Figure 61). The
orthorectified image should be saved as a TIFF file, to ensure
that all information is preserved, namely the location and the
spectral signature of each pixel.
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Figure 61.Selection to export the orthorectified image (left) as a tiff file (right)
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Among all the export options, only a few are important, the
rest are just a matter of preferences. If only the spectral bands
are exported, then the Raster Transform option MUST be set to None. If
the Raster Transform is selected to Index Value or Index Colors, then the
orthorectified image contains false colors. The colors are either a
combination of bands, basically indices (hence the Index Value option) or
in the RGB colors set in the Palette settings of the Raster Calculator
(hence the Index Colors). If a Raster Transformation is chosen other than
None, the original bands should be saved as a tiff file, irrespective the
transformation selected. However, the original bands can be saved with
the transformed bands indices (Figure 62).
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Figure 62. The window to select the option to save the orthophoto as a tif file

5.2.8

Compute Remote Sensing Indices

In many instances besides the original wavelength recorded by the sensor
a combination of them is desired. An algebraic manipulation of the
recorded spectral reflectance form at least two wavelengths is called a
remote sensing index. To compute the remote sensing index, such as the
Normalized Difference Vegetation Index (NDVI), either select within the
Export Orthomosaic window the Raster Transform or after you navigate to
Tools → Set Raster Transform,
window will appear (Figure 63).

, the Raster calculator
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Figure 63. Computation of remote sensing indices
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To compute a remote sensing index, the formula is simply
typed in the Output Bands area (Figure 63). To add more
indices, or the bands themselves, the should be pressed,
which will add a new row in the Output Bands column. In
Figure 64 three indices are computed: NDVI (Rouse et al.,
1974), Two-band Enhanced Vegetation Index (EVI2) of
(Jiang et al., 2008), and Modified Soil Adjusted
Vegetation Index (MSAVI) of (Qi et al., 1994):
𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁 =

Calculate
remote sensing
indices

𝐸𝐸𝐸𝐸𝐸𝐸2 = 2.5 ×

𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀 = 𝑁𝑁𝐼𝐼𝑅𝑅 + 0.5 − 0.5

𝑁𝑁𝑁𝑁𝑁𝑁 − 𝑅𝑅𝑅𝑅𝑅𝑅
𝑁𝑁𝑁𝑁𝑁𝑁 + 𝑅𝑅𝑅𝑅𝑅𝑅

𝑁𝑁𝑁𝑁𝑁𝑁 − 𝑅𝑅𝑅𝑅𝑅𝑅
𝑁𝑁𝑁𝑁𝑁𝑁 + 2.4 𝑅𝑅𝑅𝑅𝑅𝑅 + 1

× �((2 × 𝑁𝑁𝑁𝑁𝑁𝑁 + 1)2 − 8 × (𝑁𝑁𝑁𝑁𝑁𝑁 − 2 × 𝑅𝑅𝑅𝑅𝑅𝑅)
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Figure 64. Computation of the NDVI, EVI2, and MSAVI

There are multiple ways to display the remote sensing indices, which can
be set in the Palette tab of the Raster Calculator window. In many
instances it is recommended to normalize the value of each band, namely
to have a value between 0 and 1. The normalization of the orthorectified
images produced with Micasense Rededge MX sensor, are implemented
by dividing each digital number to 212 = 4096, as the images are 12 bits
depth (Figure 65).

Figure 65. Normalization of the 12 bits bands of the multispectral orthorectified image obtained
from the Rededge sensor.
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6 Conclusion
The start of the third millennium marks significant efforts in landscape
restoration. However, the restoration efforts were not necessarily mirrored
by monitoring the effectiveness of the restoration, as in most instances
monitoring occurs outside the time on which the restoration activities
occurs. Therefore, land managers turned to remote sensing to help monitor
the areas restored. However, remote sensing techniques are not limited to
monitoring restoration efforts, but also to monitor the landscape itself, as it
was done for the last 50 years, since the advent of the Landsat missions.
Evermore, the technological advances in computer science, particularly in
computer vision and device control, as well as in material sciences,
opened a new avenue of land survey with UAS.
The present manual, which is dedicated to researchers and practitioners
aiming at land monitoring with UAS, describes the entire process of
acquiring photos and processing them such that multispectral
orthorectified images are produced. The manual stops after the production
of the multispectral orthorectified image, as an entire field of work opens
in that moment, namely image analysis and interpretation.
The main steps in production of ortorphotos consists in mission planning,
mission preparation, execution of flight, and image processing. Special
emphasis is placed in this manual on mission planning and image
processing, but a broad overview of the rules governing the usage of UAS
in the western states of the US is also presented. The manual dedicates
entire sections to lens calibration, sensor radiometric calibration and
georeferencing to ensure the fluency of generating orthorectified
multispectral images.
There are many software packages designed for mission planning and
production of orthophotos using structure from motion. To maintain the
manual at reasonable size and make it usable for a broad audience only
packages that are free or reasonable priced were presented. Therefore, the
mission plan was shown using DJI Pilot and Pix4Dcapture, both free,
whereas the image processing was carried out in Agisoft Metashape, at the
moment when the manual was written the least expensive among the SfM
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software. A natural extension of the manual is inclusion of mission
planning software that allows adjustment of the flight to terrain, such as
Drone Deploy or UgCS, which is a very important detail in regions with
high relief energy. From the software perspective, the manual can be
extended by including image processing packages that are either free, such
as Visual SFM, or unexpansive options, such as OpenDroneMap. Of
interest for land monitoring is extraction of valid information from the
multispectral orthorectified images, which would be presented in the next
version of the manual using two standard techniques in remote sensing
analysis: supervised and unsupervised classification.
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